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This tutorial is designed to introduce you to the basics of GIS and how people use it to visualize 

and interpret geospatial data. GIS enhances our understanding of the world, and this tutorial 

will illustrate the depth of information contained in each layer and how that information can be 

accessed and understood using Esri ArcGIS Pro. The accompanying data for the tutorial is the 

Canada_Ecozones_V5b_31s_15M_simplify.shp freely available from the Canadian Council on 

Ecological Areas (CCEA). 
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What is GIS? 
The simplest answer to this question is that GIS is an acronym that stands for geographic 

information systems. Here’s an overview that covers the major concepts. 

GIS Defined 

GIS combines hardware, software, 

imagery and tabular data in order to 

collect, manage, analyze, and display 

geographically referenced information.  

GIS uses a concept known as layering to 

view, analyze, and interpret data. The 

idea behind layering is that you stack 

different layers on top of one another to 

see how they relate to one another. This 

visualization of the data reveals patterns 

and trends that contribute to improve 

workflows and the decision-making 

process. 

For example, many people use maps to 

look for distinct features such as 

schools—that’s one layer. But in order 

to figure out how to drive to the school, 

you need to see the roads. That’s another layer. And perhaps you’d like to know what district 

that school is in. That’s another layer Maps are used to visualize data in a manner that can be 

quickly and easily read and understood.  

Geographic Data 

Another name for layers is, quite simply, data. Among GIS users, data may also be referred to as 

datasets, geodata, or spatial data. GIS data can be broken down into three main types of data: 

vector, raster and tabular. Vectors represent features with distinct boundaries, and these are 

drawn using only three different types of geometry: points, lines, and polygons. The layers just 

mentioned—schools, roads, districts—are examples of vector data. 

 

 

 

 

Various layers of data covering the same 
geographic area. (Image source: Esri, Inc.) 

Lines Polygons 

Vector data represented by points, lines, and polygons. 

Points 
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In mathematics, a vector is a geometric quantity having magnitude and direction. In GIS, 

therefore, all vectors have a xy coordinate value, wherein points have a single value, lines are 

made up of two or more values connected by lines, and polygons have three or more values 

that are connected by lines and form a closed shape. Vector data maintains a constant 

resolution, which means no matter how close you zoom in on a point, it will not become blurry 

or pixelated.  

Raster data works a little differently in that it represents objects or phenomena over an 

uninterrupted surface. Raster data is stored as a grid of equal-sized cells arranged in rows and 

columns, where each cell has a specific value, either continuous or discrete. Exactly like a 

photograph, the only difference being that a raster has a scaled pixel/cell size. 

 

Continuous values represent a continuous measurement such as elevation. Discrete values 

represent a specific value such as land cover. 

 

 

 

 

 

Note that in the detail of elevation raster, each cell, or grid square, has a distinct pixel value 

that is consistent throughout the cell. This is important to remember because when the cells 

are viewed next to each other, the naked eye makes them appear as though they are changing 

from darker to lighter values as you move left to right. For example, on the left of the detail, the 

cells are yellow, but as you move toward the greenish-yellow cells in the middle, they appear to 

be darker (more green) on the left of each cell and lighter (more yellow) on the right. This is an 

optical illusion. Not only would that contradict the continuous nature of the data (yellow 

becomes green as you move across the image from left to right, not the other way around), but 

it would also negate the fact that each cell has a consistent value throughout (i.e. if the cell is 

1m2, any given pixel within that square-meter will have the same value). 

An elevation raster (and detail) showing continuous 
value cells. 

A land cover raster (and detail) showing discrete 
values. 
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With the discrete values (land cover raster), cells also have a distinct value throughout, but 

because they are not a continuous measurement, the colors of each cell do not change 

gradually or blend; instead, they change abruptly and have a much more rigid appearance. As 

the detail below illustrates, each unique value constitutes a type of land cover (i.e. 3 may be 

marshland, 5 may be water, 2 may be forest, etc.). 

Storing Data 

Another important consideration when getting started with GIS is how to store your data. Both 
vector, raster and tabular data can be stored as a variety of file types. The file type will also 
determine what kind of container the data is stored in. For example, vector data stored as a 
shapefile resides in a folder, just like common files on a PC. However, if that same data is stored 
in a geodatabase, it is considered a feature class.  

Shapefiles are by far the most common storage format, in part because they have been around 
for a long time, but also because they can be read by various types of GIS software and even 
some non-GIS software. However, they are somewhat limited in terms of performance and 
storage capacity. 

Rasters are large and take up a fair amount of drive space but this is contingent on resolution. 
As with photographs the sharper they are the more storage space they occupy. 

Tabular data is any form of table data sorted with location information stored within. It could 
be txt, csv, gpx, xlsx etc. This data is very light and can be easily transformed into location data 
by using a GIS. 

For this tutorial, we will work with shapefiles because of their ubiquitous nature. However, no 

matter what data format you choose, all data needs to be described. To do this, geospatial data 

allows you to record metadata, or data about data.  

Projections 
Projections are the basis of any spatial analysis. A projection is a way of converting spherical 

data into flat data so that it can be easily measured and precisely layered. Measuring anything 

on a sphere is mathematically intense so a GIS has many algorithms to flatten the data, 

hopefully with the least distortion. These algorithms take data, usually in Decimal Degrees and 

converts it to metres. ArcGIS will allow the user to visualize spatial data in the same spatial 

context but, for any analysis, all the layers must be in the same projection. 

 

 

 

 

    North Pole Stereographic  World Eckert VI   South Pole Gnomonic 
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Starting ArcPro 
 

ArcPro is a suite of products that include ArcMap and ArcCatalog that were separate entities in 

Arc Desktop (Map). These have been seamlessly blended along with an ArcGIS online 

connection for a very dynamic experience. We have provided the Canada Ecozones shapefile as 

a base layer for this tutorial and additional data will be acquired from an online geo hub. 

1. From the Start menu or the desktop icon , launch ArcPro and wait for the Getting 

Started window to appear.  

 

2. From this window, choose Catalog 

under New. 

3. From here create a new project. For 

now let ArcPro create the new folder 

and associated Geodatabase. This can 

be changed later if required. 

 

4. The ribbon has base tabs—Map, Insert, 

Analysis, View, Edit, Imagery, and 

Share—that are always present when a 

map view is active. Each tab has its 

own set of tools, organized in groups. 

The Catalog tab/tools are for 

interacting with files, folders and 

databases, as the Map tab has tools for 

interacting with the map.  

 

5. Create a connection to a folder that 

contains spatial data (this can also 

double as your project folder) by right 

clicking on Folders (under the Contents 

panel) and click through the dialog box 

to your desired folder. This will point 

ArcPro to the folder containing the 

spatial data. Select the (unzipped) 

Ecozones folder provided with this 

tutorial or any other folder that contains shapefiles. 
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6. Either add a new map under the Insert 

tab to add a shapefile to or right click your 

preferred shapefile and Add to new map. 

 

7. Add the Ecozones tutorial file 

(Canada_Ecozones_V5b_31s_15M_simplify.shp) 

to the map and ArcPro will shift tabs to 

the Map. 

 

 

8. The Explore tool allows you to move around the 

map as well as to get information about map 

features of interest. 

 

 

 

 

 

9.  

 

 

 

 

 

 

 

 

 

 

 

 

Contents 

Pane 

Ribbon 

Tabs 

Map View 

Docking Pane – 

Catalog, tools, 

symbology, 

properties, etc.  

Top Menu 
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10. Additional data can be added several different ways: 

a. Map tab: 

i. Add Data in the ribbon 

ii. Drag and drop a spatial data file from a 

windows explorer folder 

b. Catalog tab: 

i. Get a spatial data file from a connected 

folder (see instruction 5) 

ii. Get spatial data from other sources connected. Eg: 

1. Portal: By selecting All Portal in the contents pane this connects 

ArcPro to various online sources of data. There are more available 

if one is signed-in to ArcGIS Online. 

2. On the top right of the Catalog tab there is a Search Box. For this 

example, type in “Major Canada Cities” and right click to add the 

“Major Canadian Cities” [Ensure this is the Feature Layer from ESRI 

Canada Education] to the same map as the ecozones. 
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Symbology 
Symbology is a way of visualizing map attributes in different lights. Since, shapefiles have attributes (a 

table that contains descriptors for the individual objects that make up a shapefile) symbology can be 

changed to highlight or delineate the differences within one column. For the Ecozones shapefile we will 

highlight the different ecozones with unique colours. 

Changing size and colours 
Change the colours, size and outline of 

spatial data as a Single Symbol. All 

choices will bring up the Symbology 

properties pane on the right side. 

1. Right click on the Ecozones layer. 

2. Selecting symbology in the ribbon 

under the Appearance tab. 

3. Or, 2x clicking the symbol in the 

Contents panel. 

4. Select Unique Values. 

5. Change the Field 1 dropdown to Name. 

a. This colours each of the attribute values of Name a unique colour. 

Conditional formatting 
Some examples of making spatial data 

more dynamic using unique values or 

ranges: 

1. Unique Values 

2. Graduated Colours 

3. Graduated Symbols 

4. Proportional Symbols 

5. Dot Density  

 

The different forms of Conditional formatting allows one to highlight the attribute data 

from a shapefile by its type.  

1. Unique Values – assigns a colour to each unique value 

2. Graduated Colours – draws quantities using graduated colours (low to high) 

3. Graduated Symbols – draws quantities using graduated symbols (based on a 

chosen break method) 

4. Proportional Symbols - draws quantities using proportional symbols (sizes 

symbols according to a quantity) 

5. Dot Density – draws quantities using dot density (clustering of dots) 
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Labeling 
Labeling is a way of adding more definition to your map by verbally highlighting features to attract a 

viewer’s attention. Below are instructions on how to label the cities layer that was brought in from the 

portal. 

Adding labels to the map 
 

As with Arc Map, ArcPro can automatically label the feature layer in the map based on the 

attributes in a selected column.  

Selecting the Labeling tab on the top of the Ribbon will bring up all the properties for labels you 

can change in the Ribbon. Also, a Label Class pane on the right gives the same options as the 

Ribbon tab, plus some extended functions for creating attribute filters (Expressions). 

 

 

 

Select the Major Canadian Cities layer in the Table of Contents. On the left side of the ribbon, 

under the Field dropdown select NAME and then click the label button. Your map should look 

like the one below. 
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At this point in the tutorial your map should like this. 

Selecting Data 
 

GIS software allows for the organization and visualization of large amounts of data in many 

different formats. As mentioned previously, vector data is made up of 3 forms; points, lines, and 

polygons. Every one of these shapes is attached to an attribute table that describes it. E.g. a city 

point has name and province attributes. 

Large amounts of spatial data are difficult to manually filter. GIS are designed around being able 

to extract specific data in two ways; Select by Attribute and Select by Location. This means a 

user can query the table data and query the visual data.  

Select is a means of highlighting spatial data, it does not change any of the data. For example: If 

one is looking for the top 5 major cities in Canada to be ranked alphabetically, all one must do is 

open the attribute table (right click on the Major Cities Layer in the TOC), sort A-Z by double 

clicking the header of the NAME column and select the first 5 rows. This will highlight the top 5 

cities in cyan on the map and in the attribute table. Select shows the connection between the 

table and the objects in shapefile. With this we can visualize chosen aspects of our layers. 
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Select by Attribute 
 

 

 

Selecting by attribute is like querying a database table. Arc Pro allows the user to create SQL statements 

by clicking dropdown list boxes. For this example, we are going to find all the Great Lakes Ecozones by 

the Name attribute. 

 Querying the table data: 

1. Right click on the Ecozones layer in the Contents panel 

and select Attribute Table or Ctrl-T. 

2. Clicking Select by Attributes under the Map tab Ribbon 

opens the Geoprocessing dialogue box. 

3. Choose the Ecozones layer to Query its attributes. 

4. Build a SQL statement by clicking Add Clause. 

5. Select the column in the table (Name) which is to be 

queried. “Where” Name … 

6. Select the appropriate logical expression. “is equal” … 

7. Select Great Lakes in the dropdown. “Great Lakes” 

8. The full SQL will be: “Select from Ecozones Where 

Name is equal to Great Lakes” 

9. Click Apply 

10. You will see the row with Great Lakes under the Name column in the table and the 

Ecozone around the Great Lakes on the map highlighted in Cyan. 
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Select by Location 
 

 

 

Selecting by location is a way to spatially compare two different layers. In a GIS one can find all the 

points within a search distance of a line (E.g.: Find all the Osprey nests within 200m of roads), find lines 

that intersect polygons (E.g.: Find all the roads that cross flood plains), and find which polygons contain 

points.  For this Select by Location example we will find which Ecozones don’t have Major Canadian 

Cities.   

 

Querying the location data:  

1. Clicking Select by Location under the Map tab Ribbon 

opens the Select by Location dialogue box. 

2. Choose the Ecozones layer as the top Input Feature.  

3. Select the Completely contains Relationship. 

4. Then set your Selecting Features as Canada Major 

Cities. 

Since we are trying to find where the Major Cities are 

NOT in the Ecozones we need to invert the spatial 

relationship. 

5. Check the Invert Spatial Relationship check box. 

6. Click Apply 

7. You will see the Ecozones that do not contain any City points outlined in cyan on the 

map.  Also, if you have the Ecozones attribute table you will see some of the rows 

highlighted in cyan and at the bottom of the table it should say 18 of 31 selected. 
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As mentioned previously these two methods of 

selection only highlight your choices and do not 

change the base data. From here you can export 

the data to create a new shapefile containing only 

the selected data. 

Right click the Ecozones layer in the TOC, click 

Data, and click Export Features. 

Select an Output 

Location. 

Give your new shapefile a 

useful name describing 

the data created under 

Output Name. E.g.: 

“Ecozones_no_Cities”. 

And click OK to save. 

 

When finished with your selections or wish to create new ones be sure to click the Clear selection 

button in the ribbon. This removes all your selections and the cyan highlights from the map and table. 

 

Creating a Layout for Export or Print 
To finalize your map or figure you will need to create a layout. This is the best way to put together your 

map’s symbology and labeling in a cohesive manner for your research. This section shows one how to 

size, title, add legends, direction, etc. to their map. One of the layout choices is where the map is 

currently zoomed to, in this case we will zoom in to Southern Ontario. 

 

Layout 
 Select New Layout under the Insert tab in the ribbon. 
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Once you have a paper size, ANSI letter 

(8.5X11 inches, a normal sheet of 

paper). This will give you an idea of how 

large your map will be.  

 

 

 

 

 

 

Once a paper size is selected a new 

Layout tab will open and change the 

context of the Map and Insert ribbon 

tabs. 

 

 

 

 

 

 

1. Insert a Map Frame – Select one of the two choices: 

a. Default Extent: is the full map extent including the 

base map. 

b.  Representative Fraction Scale: is the scale of the 

zoomed in data frame. In this case Southern Ontario 

 

2. Select the Representative Fraction. 

3. Click and drag out the size of rectangle you want the map to 

take up on the layout sheet. The Map Frame can be resized 

later. 
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4. To move the map around in the Map Frame: 

a. Select the Layout tab 

b. Click the activate button 

 

 

 

 

 

 

c. This allows one to move and zoom the map within the Map Frame. 

 

d. When the Map Frame is all set-

up the select the Layout tab and 

click close activation. 

 

 

 

5. To add the rest of the pertinent information to your layout like North Arrow, Scale Bar, Legend 

and Title go back to the Layout tab. These additions are dynamic so they will change as the 

map information changes. 

 

 

 

 

a. North Arrow – if required, click on North Arrow button, select a North Arrow that 

suits your map and draw the rectangle size that you need. The arrow will adjust its 

angle to the maps North. 

b.  Scale Bar – click on the Scale Bar button, select a North Arrow that suits your map 

and draw a rectangle anywhere on your layout. Since these are dynamic, adjust the 

length of the Scale Bar box to have the scale be an easily recognizable number (0 - 

200 kilometers). The properties for the scale bar can be changed in the properties 

panel that shows up on the right side. 

c. Legend - click on the Legend button and draw a rectangle anywhere on your layout. 

This legend will show all the visible layers on the map. Legend properties can be 

changed in the panel to the right. 
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d. Adding Text – select the first A (Rectangle text) in the Graphics and Text area of the 

Insert ribbon.  

 

 

 

i. Draw a rectangle for your text box on your sheet in 

the layout view where you want your title to be 

(Ecozones of Southern Ontario). 

ii. To change the Text Symbology – Size, Colour, Bold, 

Font etc. select Text Symbol in the Elements panel on 

the right side. Here you can change the font size to 20 

pt. 

iii. After making changes to the text click Apply at the 

bottom of the panel. 

iv. Also, remember to properly cite your map data. 

 

6. Move around and resize the layout components and your map layout should look like this. 

 

Created by Markus Wieland for the UW Geospatial Centre 

Canadian Council on Ecological Areas (CCEA). Canada_Ecozones_V5b_31s_15M_simplify.shp developed in a joint initiative between Environment Canada (EC) and Agriculture and Agri-Food Canada (AAFC) 

between 1992 and 1995 and published in 1996. Based on interpreted to the Soil Landscapes of Canada (SLC), a national 1:1,000,00 soil map. (2014) 

ESRI Education Canada. Major Canadian Cities feature layer available on the ESRI portal. Created by Natural Resources Canada (NRCAN) 2016. 

Projected Coordinate system: NAD 1983 Canada Atlas Lambert 
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7. As mentioned previously the map elements are dynamic and can be changed from the Data 

view. For example, rename the Canada_Ecozones_V5b_31s_15M_simplify in the table of 

contents to Canada Ecozones. This will change the Ecozone title in the Legend to a more 

understandable value title. This re-naming does not change the original file name, it only 

changes the layer name in the TOC and correspondingly the title in the Legend. 

Printing and Exporting 
To Print or Export select the Share tab: 

Print 
Click the printer icon and follow the choices 

and instructions in the Print Layout panel on 

the right. 

Export 
Click the arrow icon, choose the image file 

type and the resolution in the Export Layout 

panel on the right. 

 

 

This tutorial covered the basics of GIS and getting started with ArcPro. If you have any questions on 

learning more about ArcGIS and how to incorporate it into research, please contact us. 

 

Contact Us 

Geospatial Centre 

Dana Porter Library, Room 328  
University of Waterloo Library  
Waterloo, Ontario N2L 3G1 (519) 888-4567 ext 32795 
LibraryGEO@library.uwaterloo.ca 
 
Ecozones Shapefile: 
Canada_Ecozones_V5b_31s_15M_simplify.shp 
Obtained from the Canadian Council on Ecological Areas (CCEA) 
https://www.ccea.org/ecozones-downloads/ 
 
 
 
 
 
 

Created by Markus Wieland for the University of Waterloo Geospatial Centre (2020) 

mailto:LibraryGEO@library.uwaterloo.ca
https://www.ccea.org/ecozones-downloads/

